SWARM, Seismic Wave Analysis and Real-time Monitor: user manual and reference guide

February 6, 2011
# Contents

## 1 Introduction

1.1 About ........................................ 3
1.2 What's new in Version 2.0 .......................... 3
1.3 System requirements and installation ................. 4

## 2 Getting Started

2.1 Forewarning: Windows-centrism of this documentation .......... 4
2.2 Installing SWARM .................................. 4
2.3 Running SWARM ................................... 5
2.4 Quick demonstration of some new SWARM 2.0 features .......... 5
2.5 Quick start tutorial .................................. 5
  2.5.1 How to create a new data source .................. 5
  2.5.2 How to create a helicorder ....................... 5

## 3 Data Sources and Channels

3.1 Introduction ....................................... 6
3.2 Description and uses .................................. 6
3.3 Data sources in detail ............................... 7
  3.3.1 Earthworm Wave Servers ......................... 7
  3.3.2 Winston Wave Servers .......................... 7
  3.3.3 DMC ........................................ 7

## 4 Helicorder Views

4.1 Introduction ....................................... 8
4.2 Helicorder View Settings ............................ 8
4.3 Axes Options ....................................... 8
4.4 Zoom Options ....................................... 8
4.5 Other Options ...................................... 8
4.6 Toolbar and Keyboard Interaction ..................... 9

## 5 Wave Views

5.1 Introduction ....................................... 9
5.2 Wave View Settings Dialog .......................... 9
5.3 General View Options ............................... 9
5.4 Wave Options ...................................... 10
5.5 Spectra/Spectrogram Options ......................... 10
5.6 Filtering .......................................... 10
5.7 Keyboard Interaction with Wave Views .................. 11

## 6 Real-time Wave Viewer

6.1 User Interface ..................................... 11
6.2 Toolbar and Keyboard Interaction ..................... 11
1 Introduction

1.1 About

SWARM, Seismic Wave Analysis and Real-time Monitor, is a Java application designed to display and analyze seismic waveforms in real-time. Furthermore, SWARM can be used as a much lower cost, more functional replacement to the traditional helicorder. Seamlessly integrated into its rich user interface, SWARM has many commonly used tools for visualizing seismic waveforms quickly and effectively such as frequency spectra plots, spectrograms, band-pass filtering, easy navigation, etc.

SWARM was developed at the Alaska Volcano Observatory (AVO) in July and August, 2004, and underwent several improvements over time.

1.2 What’s new in Version 2.0

- An interactive map showing seismic station locations and geographic features. Helicorder and wave views can be easily summoned by clicking on the station names. Live waveforms can be displayed with geographic context.

- Support for server-side metadata. When SWARM connects to a Winston Wave Server (WWS) it can receive station metadata, including latitude and longitude, time zone information, calibrations, etc.

- Support for IRIS DMC connections. SWARM can connect directly to an IRIS DMC and receive real-time waveforms from hundreds of seismic stations world wide. DMC connections also provide longitude/latitude information for map displays.

- User defined layouts retaining specific helicorder, wave, or map settings such as screen arrangement, axis limits, time scales, etc.

- Improved and updated graphical user interface (GUI).
• Improved config file management.
• Improved waveform cache performance, especially in monitor mode.
• Increased flexibility in channel grouping.

1.3 System requirements and installation

SWARM will run on any system with a graphics display and a Java Virtual Machine 1.5 (also known as J2SE 5.0) or greater installed. However, it should be noted that as SWARM frequently deals with large quantities of data and performs complex calculations on said data, system memory and processor speed will have a large impact on its general performance.

The latest versions of Java can be found at the Oracle Java Technology page (http://www.oracle.com/technetwork/java/index.html). The Java Runtime Environment, or JRE, is sufficient; the full Java Software Development Kit (SDK) is not needed.

Once the Java Virtual Machine has been installed, the system is ready for a SWARM installation. The latest SWARM package can be downloaded, as of now, from the ISTI website (direct URL: http://www.isti2.com/ew/distribution/swarm-2.0rc3.zip). This archive contains everything needed to run SWARM. The entire package content is located under the /swarm directory so it’s usually possible to safely extract it anywhere.

After extracting the SWARM package content into a directory of user’s choice, starting SWARM is just a matter of executing either swarm.bat on Windows, or swarm.sh on other platforms. If desired, it’s possible to create a custom script to start SWARM (see the section on Advanced Topics).

2 Getting Started

2.1 Forewarning: Windows-centrism of this documentation

Some of the documentation that follows tends to be Windows-centric. SWARM is written in Java and is known to run on Mac OS 10, Solaris, several Linux distributions and Windows. It is assumed that users running a non-Windows operating system will be knowledgeable enough to adapt such Windows-centric instructions to the particularities of their own OS.

2.2 Installing SWARM

Once a Java environment is running, installing SWARM consists of nothing more than unpacking its binary distribution. The following items will be unpacked in the /swarm directory:

• /layouts A directory containing user-defined layouts.
• /lib A directory containing the libraries used by the SWARM application.
• /mapdata A directory containing Map Packs.
• `swarm.sh` A shell script that starts the SWARM application (for Unix, Linux, and Mac).

• `swarm_console.bat` A batch file that starts the SWARM application (for Windows). This will keep a command console open which will display various text messages from the application that might be informative.

### 2.3 Running SWARM

Double clicking on `swarm.bat` or `swarm_console.bat` will open the main SWARM window shortly. If nothing happens, it’s suggested to open a command prompt console (on the Windows task bar, `<Start> → <Run> → cmd.exe`), navigate to the SWARM directory and run `swarm.bat` manually from there. By doing this, any Java exceptions will be written out and able to be examined for troubleshooting.

### 2.4 Quick demonstration of some new SWARM 2.0 features

Once SWARM is running, executing `Augustine` from the the `Layout` menu will open some relevant screens.

### 2.5 Quick start tutorial

This short tutorial is designed to get the user using SWARM productively in just a few minutes. Note that SWARM is set to open in a window that will fit on a 1024x768 screen. SWARM is significantly more usable at higher resolutions. Helicorders display a large quantity of data and the more pixel area is given to them, the better.

#### 2.5.1 How to create a new data source

SWARM comes pre-configured with the AVO Winston Wave Server. Unless only Alaska data is of interest, SWARM will have to be instructed about where to look for data.

The University of Washington operates a publicly facing Earthworm Wave Server. To add it, click the icon on the Data Sources panel in the upper left of the SWARM interface. A `New Data Source` dialog window will open. Open the tab labeled `Earthworm Wave Server`, then pick a name for the data source such as `UW EWS`. The IP address is `128.95.16.105`, and the port is `16021`.

The other options can be initially left at their defaults. Alternatively, a data source pointing to the Yellowstone Volcano Observatory (YVO) Winston Wave Server could be created: `137.227.233.44/16022`.

#### 2.5.2 How to create a helicorder

Double-click the new data source and a small file folder icon should appear, labeled `All`. Clicking on this folder will open a list of channels. It’s possible to select one or more channels. Once channels have been chosen, press the helicorder button on the bottom left of the data chooser panel. A helicorder window will appear.

A full 24 hours of data should be able to be downloaded in a matter of seconds when connecting to a Winston Wave Server (WWS), since Winston servers store pre-calculated
helicorder data. When connecting to an Earthworm Wave Server (EWS), a slow helicorder backfill will be experienced as the raw waves are gulped and downsampled.

3 Data Sources and Channels

3.1 Introduction

After starting SWARM, a panel will be visible on the left side of the main screen (figure 1). This is the Data Source Chooser and Channel Selector. It’s possible to adjust the size of the two panels by adjusting the split line in the center, either by dragging with the mouse or clicking on one of the small arrows.

The Data Source Chooser, the top half of the panel, is used to select the source of the waveform or helicorder data. The box contains the list of all available data sources, both ones that have been used before and new ones that are created.

The Channel Selector, the bottom half of the panel, is used to select a channel, either the waveform or the helicorder. Once a data source is selected, the Channel Selector will be populated with the available channels. The contents of both the Waves and Helicorders lists depends on the data available from the selected data source.

3.2 Description and uses

The binary distribution ships preconfigured with an AVO Winston Wave Server and an IRIS DMC connection to a New Zealand network of broadband seismometers. It’s possible to add a custom data source by clicking on the icon. Other icons let the user to:

- Edit a data source
- Roll up the data source channel trees
- Delete a data source

The × icon lets the user dismiss the whole data source chooser window if more space is desired. To get it back, type CTRL-D or go to the Window menu and check Data Chooser. The icons associated with the different data sources have the following meaning:

- A data server that the user added manually with the icon.
- A data server that is in the DataSources.config file. The small padlock denotes that it’s not possible edit or delete it from the SWARM application. The rationale for this distinction is that in an environment where multiple people are running SWARM from the same location (a network drive, for example), it is desirable to prevent users editing or deleting certain data sources.
- Data servers that are broken, i.e., not responding.
- Data channels available after opening a SEED or SAC file from the File menu.
Double clicking on a data source will cause a channel tree to appear, listing the available channels. Double clicking on a channel will bring up a helicorder. Alternatively, it’s possible to select a channel (or channels, with Control- or Shift-click on Windows) and press one of the five buttons at the bottom of the data chooser:

- ![Helicorder Views](image)
  - Opens helicorder views
- ![Clipboard](image)
  - Puts waves on the clipboard
- ![Real Time Monitor](image)
  - Puts waves on the real time monitor
- ![Real-Time View Window](image)
  - Opens waves in the real-time view window
- ![Map](image)
  - Shows channels on a map

Note that for complete control it’s also possible to manually define data sources with a `DataSources.config` file in the SWARM directory.

### 3.3 Data sources in detail

SWARM can currently retrieve data from a few different places.

#### 3.3.1 Earthworm Wave Servers

To connect to an Earthworm Wave Server (technically, the `wave_serverV` module of the USGS Earthworm system) it’s necessary to create a new data source. Click on the New button on the Data Source Chooser (figure 2).

A unique name for the data source (which is then displayed in the Data Source Chooser), the Wave Server host name or IP address, port number, and communication timeout time (under most circumstances the default of 2 seconds is fine) are also needed.

An Earthworm Wave Server data source will populate both the Waves and Helicorder lists of the Channel Selector. Some clarification about how this works is in order. An Earthworm Wave Server actually only provides raw wave data, not derived helicorder data. When a helicorder view based on Earthworm Wave Server data is chosen, SWARM starts a process called a *Gulper* that slowly downloads data to fill in the requested helicorder time interval. This process will take several minutes. One positive side effect of this process is that the raw wave data will be immediately available for viewing and analysis from the SWARM cache.

#### 3.3.2 Winston Wave Servers

Winston Wave Servers are another data source for SWARM. Winston Wave Servers store both derived helicorder data and raw wave data. More information forthcoming.

#### 3.3.3 DMC

More information forthcoming.
4 Helicorder Views

4.1 Introduction

One of the main scopes of SWARM is being a tool for interacting with and displaying helicorders. Figure 5 shows a typical helicorder view (actually, this is smaller size than typical in order to fit into the manual better).

The view consists of a window displaying the data source [AVO Winston] and the channel RSO_EHZ_AV. In the window there is the helicorder, bordered on the top by a toolbar and on the bottom by a status bar that shows the time under the mouse cursor. The spectrogram inside the helicorder was generated when the user clicked on the helicorder. A small transparent yellow box under the inset wave view shows the area that is being magnified.

Helicorders derived from an active source, like a Wave Server or Winston connection, will automatically update themselves when new data are available.

4.2 Helicorder View Settings

There are two main ways in which the user can interact with the a helicorder view: manipulating the helicorder view itself or zooming in and looking at the underlying waveform. All of the settings for the helicorder view can be manipulated in the helicorder view settings dialog which can be opened by clicking on the button. The settings dialog box is shown in figure 6.

4.3 Axes Options

These settings effect the size of the X and Y axes. The X axis determines the number of minutes to display along the bottom. Legal values are 10, 15, 20, 30, 60, 120, 180, and 360. Values above 60 are seldom used. The Y axis determines how much total time to display on the helicorder and is measured in hours. Legal values are 2, 4, 6, 12, 24, 48, 72, and 168. The default settings generate a 12 hour helicorder with 15 minutes rows.

The last settings under Axes is View time. This setting allows to set the time at the bottom of the helicorder. By default a helicorder view opens with the bottom being set to 'Now’. The format for specifying the bottom view time is YYYYMMDD or, if more resolution is needed, YYMMDDHHMMSS.

4.4 Zoom Options

The zoom settings allow to customize the display of the zoomed waveform view. The first setting, Zoom determines the amount of time on either side of the mouse cursor to zoom. Also available is a button to display the Wave View Settings Dialog.

4.5 Other Options

These settings configure various other options for the helicorder view.

Refresh is the number of seconds between attempts to refresh the helicorder with the latest data, the default value is 15.
 Scroll size is the number of helicorder rows to scroll up or down on user scroll requests with the mouse-wheel or the scroll toolbar buttons.

The next option Force Center forces each helicorder sample to be centered on its current line. This effectively eliminates all drift and is useful for broadband stations with lots of low frequency energy. This feature is to be used with caution though: it can make an obviously false signal look like an earthquake.

Auto-scale toggles helicorder auto-scaling on and off. When auto-scaling is on an attempt is made to produce a “pleasant” looking helicorder. If this fails, or if more control over the appearance of the helicorder is wanted, set the One bar range. The One bar range is the number of counts on either side of zero that make up one bar. For example, if there is a seismometer that reports counts between -3600 and 3600 and a bar range of 1200 is selected, a full-range waveform will take 3 bars, overlapping one above and one below. This is best understood through experimentation.

The last options are Show clip and Clip threshold. They allow to set a counts threshold after which the trace will be shown in red.

4.6 Toolbar and Keyboard Interaction

There is toolbar of several buttons at the top of each helicorder. Check Appendix C.3 for details. Note that when an inset wave view is open, the standard keys for interacting with wave views are active.

5 Wave Views

5.1 Introduction

Wave Views are one of the two fundamental data views in SWARM. Any time a wave view is seen in SWARM there are settings associated with that individual view. Even a wave view has been pasted to the clipboard from somewhere else has its own view settings. This section deals with the different wave view settings and does not actually discuss the environments in which the wave views occur (such as on the Wave Clipboard or a Real-time Wave Viewer) but only the different ways a wave can be viewed. Figures 7, 8 and 9 are an example of the three general types of wave views available in SWARM. For this example a small regional earthquake has been used.

5.2 Wave View Settings Dialog

Of course, there are several ways in which is possible to change how to look at these plots. All options for the wave view are available through the Wave View Settings Dialog. To open the Wave View Settings Dialog it’s usually possible to press the ? key or click on the Wave View Settings Button, . See figure 10.

5.3 General View Options

They set the general display mode for the wave. It’s possible to select from Wave, Spectra, or Spectrogram as shown in figure 10. It can also be set whether or not the bias (mean value) is removed from the wave. By default, Remove Bias is checked.
5.4 Wave Options

These options are specific to standard Wave views and only determine how y-axis scaling is done. When Auto-scale amplitude is checked SWARM determines how to scale the y-axis using a special algorithm. If it is unchecked than the values in the user-specified Minimum amplitude and Maximum amplitude boxes are used as the y-axis limits.

The auto-scaling algorithm is fairly simple. In the simplest case, when Auto-scale memory is unchecked, the y-axis is simply set to contain the minimum and maximum values attained by the wave in the shown time interval. However, if Auto-scale memory is checked (it is by default), then this particular wave view will remember the minimum and maximum values it has attained and always choose those regardless of the amplitude of the shown wave. This makes comparing relative amplitudes a trivial visual comparison. If Auto-scale memory is subsequently unchecked it will still remember its limits if it becomes turned on again. Pressing the \texttt{R} key when interacting with a wave will reset the auto-scale memory.

5.5 Spectra/Spectrogram Options

These options are specific to the Spectra and Spectrogram wave views. The first three options, Auto-scale power, Auto-scale power memory and Maximum power behave in fundamentally the same way as the auto-scaling described in the previous section.

The Minimum frequency and Maximum frequency boxes specify the dimensions of the x-axis in spectra mode or the y-axis in spectrogram mode. There is no auto-scaling done for these axes. While SWARM will allow the maximum frequency to be set to any positive value greater than the minimum frequency, this value will adjust automatically if it is greater than the Nyquist frequency of the wave being manipulated.

The Log power checkbox sets the power axis to log mode. This also works for spectrograms. The Log frequency checkbox sets the frequency axis to log mode. This has no effect in spectrogram mode.

The last two options, FFT bin (samples) and Spectrogram Overlap (%) only affect spectrograms. FFT bin defines the number of samples to be used in each FFT. Adjusting this value affects the dimensions of each pixel of the spectrogram, increasing the number of samples increases the vertical resolution while decreasing the horizontal resolution and vice versa. The default Auto option picks a value that attempts to have medium resolution on each axis.

Spectrogram Overlap determines the amount of overlap in consecutive FFTs. Legal values are between 0 and 95. The higher this value is set the smoother the FFT will look. Note, however, that artifacts can occur when excessive overlap is used.

5.6 Filtering

SWARM allows to filter waves using a Butterworth filter. The ‘Enabled’ checkbox turns the filter on and off.

The three types of filters available are Low pass, High pass, and Band pass. The Low pass filter passes over the low frequencies and filters the high frequencies. When Low pass is selected only the Maximum hz box will be editable - this is the corner frequency of the low pass filter. The High pass filter passes over the high frequencies and filters the low frequencies. When High pass is selected only the Minimum hz box will be editable -
this is the corner frequency of the high pass filter. Lastly, the Band pass filter passes over a band of frequencies and filters frequencies higher and lower than the band. When Band pass is selected both the Maximum hz and Minimum hz boxes will be editable - these are the corners of the band pass filter.

The Zero phase shift option runs the specified filter both forward and backward. This eliminates any phase shift effects due to the filter at the expense of effectively doubling the filter order.

The Order slider allows to set the order of the filter as even values between 2 and 8, inclusive. In general, the higher the order the steeper the cutoff at the corner frequencies.

5.7 Keyboard Interaction with Wave Views

Whenever the user is interacting with a Wave View, a number of keyboard shortcuts will be active. See Appendix C.2 for details.

6 Real-time Wave Viewer

6.1 User Interface

For viewing the absolute latest available data SWARM includes the Real-time Wave Viewer (figure 11).

The white area to the right shows the lag between now and the last available data at the time of refresh (which occurs every two seconds). It’s possible to switch between views of 15, 30, 60, 120 (default), 180, 240, or 300 seconds. The time displayed is UTC.

6.2 Toolbar and Keyboard Interaction

There is a toolbar of buttons at the top of each wave viewer. Check Appendix C.4 for details. Note that the standard keys for interacting with wave views are also active.

7 The Wave Clipboard

7.1 User Interface

The primary forum in SWARM for intense interaction with waveforms is the Wave Clipboard (figure 12).

The Wave Clipboard holds as many simultaneous wave views as desired. It’s possible for example to compare arrival times across many stations, look at the same waveform with three different filters, or compare different events from one station.

The user interface consists of a clipboard toolbar at the top and then as many stacked clipboard wave views as desired, each with its own toolbar. It’s also possible to zoom into any portion of a wave (the transparent yellow block is showing the act of zooming). As usual, the status bar shows the current time under the mouse cursor. The wave with the blue border is the selected wave for the purposes of the clipboard toolbar.
7.2 Clipboard Toolbar

The clipboard toolbar has five general purpose buttons:

- Open a wave text file as saved by SWARM or a SAC file. If a directory is selected, all of the .txt and .sac files in it will be loaded.

- Save a wave as a text file or SAC file. The format of the text file is exceedingly simple: each row has two values, a time (Unix time: milliseconds seconds January 1, 1970) and a sample. Loading this data into Matlab is trivial with the command: `load filename.txt`. Any filename that does not end with .sac will be saved as one of these text files (".txt" is the default). If the filename ends with .sac the wave is saved as a SAC file.

- Save all of the waves as SAC files. The user will be prompted to specify a directory in which to save the waves. In that directory a directory will be created in YYYYMMDDHHMMSS form that corresponds to each distinct second at which each wave on the clipboard begins. Under those directories SAC files will be saved with the name of the channels whose waves start during that second.

- Synchronize all of the channels on the clipboard to the same time window as the selected wave.

- Remove all of the waves from the clipboard.

7.3 Clipboard Wave Toolbar and Keyboard Interaction

Each wave on the clipboard can be interacted with the clipboard toolbar. Check Appendix C.6 for details.

8 The map

8.1 Description and uses

The map shows station locations on geographically projected background imagery. Imagery can be, for example, shaded DEMS, satellite imagery, aerial photos, coastlines, etc. By default a basic world map taken from NASA Blue Marble imagery is provided. Custom imagery is fairly easy to add, provided that unprojected, geo-registered image files are available. See map packs for more information.

To bring up the map, type `CTRL-M` or go to the Window menu and check Map (figure 13).

8.2 Using the map to show a network

Choose the AVO Winston data source and select the All group. Press the icon at the bottom of data chooser. A map of the Aleutian arc should appear showing several transparent station markers. Note that to avoid clutter not all stations are displayed at this scale. The number of hidden channels is displayed in the lower left of the map panel.
8.3 Controlling the Map

The icons located at the top of the map panel that control the map are defined as follows:

8.3.1 Settings

-  Change map settings. This button displays a dialog box that allows the user to set certain settings for the map window.
-  Change label settings. Toggles between: show all labels, show no labels, show some labels.

8.3.2 Wave Modes

-  Real-time mode. A toggle that controls whether waves on the map update in real-time.
-  Synchronized time with helicorder wave. A toggle button that controls whether a zoom in on a helicorder dictates the time span of the wave panels on the map. This capability is useful for roughly estimating earthquake locations based on arrival times. Helicorder linking is on by default. It can be turned off by clicking on the icon.

8.3.3 Pan, zoom, and recenter

Right-clicking on the map will recenter at the clicked point.

-  Drag the map. If this toggle is selected, then left-clicking and holding allows the user to drag (pan) the map.
-  Zoom into box. If this toggle is selected, then left-clicking allows the user to draw a box. The image is then zoomed to the box area.
-  Measure distances. See Using the ruler tool.
-  Zoom in.
-  Zoom out.
-  Last map view. Restores map to its previous zoom level and location.
-  Save map image to a file.

8.4 Using the ruler tool

The ruler tool measures great circle distances and azimuths. Distances are measured by left-clicking on the map at the desired start point and then moving the mouse, while holding down the right button, to the desired end point. The distance and azimuth will be displayed at the lower left of the map panel. Note that because great circles are used, the distances and azimuths may seem counter-intuitive when looking at large scale maps. Once finished with the ruler, it’s possible to click on the or icons to re-enable drag-box area selection or panning.
8.5 Understanding the map scale

The map scale is shown in the upper left of the map panel. The scale is accurate at the center of the map and diminishes in accuracy with distance from the center. Inaccuracy is high for small maps and low for large maps.

8.6 Interacting with channels on the map

Left-clicking a station marker will produce a wave view on the map. The wave view can be moved around the map by dragging the title bar. A tie line will point back to the station location. An individual wave view can be resized by holding the mouse over the panel and moving the mouse wheel. Moving the mouse to spots not over a wave panel and moving the mouse wheel while holding the CTRL key will resize all the wave view panels simultaneously.

A left double-click will open a helicorder.

Right-clicking on a station marker will show multiple channels (if present) and allow a selection from them. Metadata will also be displayed here (not implemented as of yet).

8.7 Time span of wave panels

All wave view panels on a map have the same time span. The time span is adjusted with the follow icons:

- ⌚ Scroll left by 20%
- ⌚ Scroll right by 20%
- ⌚ Go to a particular time
- ☹ Decrease time span
- ☹ Increase time span

Clicking the ⌚ icon will reset the time axis to its last span.

The vertical red line on the wave panels always points to the same time on every panel.

8.8 Map packs (Background imagery)

SWARM uses unprojected, georeferenced .jpg or .png images to produce map background. By default the imagery is in the /mapdata directory of its installation. This can be changed in Swarm.config. Sub-directories in /mapdata are called Map Packs. The binary distribution of SWARM includes world and nasa_2k Map Packs. The file MapPack.txt provides SWARM the information needed to render the imagery. This is the first line from MapPack.txt in /world:

world.jpg, 2700, 1350, -180, 180, -90, 90, 0, 2000000, 0

The comma-separated fields are defined as follows:

1. The name of image being described.
SW ARM can be used as a much lower cost, more functional replacement to the traditional helicorder by using its Kiosk Mode. In Kiosk Mode SW ARM displays all of the open helicorders in full-screen mode. This makes seismic monitoring as easy as a glance at the screen while still allowing the standard helicorder zooming. Of course, if it’s desired to look at other stations or use the Wave Clipboard it’s possible to just leave Kiosk Mode. F11 toggles between Kiosk Mode and normal operation.

Because there are no menus or toolbars when in Kiosk Mode keyboard shortcuts will have to be used to interact with the inset wave view. Alternatively, it’s possible to just switch to normal mode.

9.2 Configuring Automatic Kiosk Mode

SWARM can be automatically start in Kiosk Mode by running it with this option:

`--kiosk=[parameters]`

In alternative, it can be started through the configuration file. The value of the ‘kiosk’ parameter is

`[server name];[channel]`

Example:

\verb|swarm --kiosk="localhost;BGL SHZ AK" --saveConfig=false --timeChunk=15|

The data source specified has to be one of the configured data sources. See Advanced Topics, for more information about this topic.
10 Advanced Topics

10.1 Time Zones

SWARM 2.0 has much better time zone awareness than earlier versions. Time zone settings are available under the Edit → Options menu. If a connection to a WWS has been established and has time zone metadata (as the AVO Winston server) then checking the box labeled "Use instrument time zone if available" will do as the name suggests. If the instrument time zone is not available via metadata, it's possible to use the machine time zone or select one manually.

10.2 Calculating the Current Time

Oftentimes SWARM needs the current time in order to make requests to data sources. In order to make sure that SWARM asks for the correct time it attempts to synchronize with Internet time servers (see http://www.boulder.nist.gov/timefreq/service/time-servers.html). This does not change the system clock, it just calculates an offset from it. SWARM will attempt this synchronization by default approximately every 10 minutes.

10.3 Layouts

A layout is a saved SWARM configuration that can be quickly re-opened, either from the SWARM menu or via a the command line. At AVO, layouts are used in the operations room to configure multi-monitor displays, depicted as in figure 14. Typically, 9 monitors are used for helicorder display, with the 10th as a control monitor.

It's possible to specify a list of NTP servers, a timeout value (ms), and a recalibration interval (ms) in a configuration file called NTP.config. Here is an example:

```plaintext
servers=130.118.179.207,129.6.15.28,132.163.4.101,128.138.140.44,192.43.244.18,131.107.1.10
timeout=600000
recalibrationInterval=10000
```

10.4 Configuring Channel Groups

SWARM looks through a file called SwarmGroups.config to groups channels in the Channel Selector. The file is very simple: just a list of [channel]=[group] pairs. Use the default file that comes with the SWARM distribution as a guide.

A Frequently Asked Questions (FAQ)

A.1 How does auto-scaling work?

Please refer to section 5.4

A.2 What about bias on the helicorders?

Bias is removed on a per line basis from the helicorders.
A.3 What does red mean on the helicorders?

Red means that the helicorder is clipped according to the current settings. See section 4.5. It does not necessarily mean that the signal is clipped.

B Menu reference

B.1 File

- Exits exit SWARM

B.2 Edit

- Options... edits application-wide settings, current only time zone settings.

B.3 Window

- Tile Helicorders tiles all open helicorders.
- Tile Waves tiles all open waves.
- Kiosk Mode enters Kiosk mode.

B.4 Help

- About... opens the About box which displays some information about memory usage.

C Complete Keyboard Reference

C.1 Application Level Keyboard Shortcuts

These keys work at all times.

- F11 - toggle Kiosk Mode.
- Ctrl-F12 - Empty cache.

C.2 Wave Interaction Keyboard Shortcuts

These keys are active whenever you are interacting with a wave view:

- ? - Open Wave View Settings Dialog
- W or , - Toggle Wave view mode
- S or . - Toggle Spectra view mode
- G or / - Toggle Spectrogram view mode
• F - Toggles filter on and off
• L - Toggles between the four different log axes states
• R - Resets auto-scaling memory

C.3 Helicorder Toolbar and Keyboard Shortcuts
• Opens the settings dialog.
• Scrolls the display (helicorder or wave inset) back in time.
  Keyboard shortcut: A
• Scrolls the display (the helicorder or wave inset) forward in time.
  Keyboard shortcut: Z
• Decreases number of minutes on the X axis.
  Keyboard shortcut: Alt-Left arrow
• Increases number of minutes on the X axis.
  Keyboard shortcut: Alt-Right arrow
• Decreases amount of time on the Y axis.
  Keyboard shortcut: Alt-Down arrow
• Increases amount of time on the Y axis.
  Keyboard shortcut: Alt-Up arrow
• Decreases zoom window size (zooms in).
  Keyboard shortcut: +
• Increases zoom window size (zooms out).
  Keyboard shortcut: –
• Opens the Wave View Settings Dialog for the inset wave view.
  Keyboard shortcut: ?
• Chooses wave view for the inset wave view.
  Keyboard shortcut: W or ,
• Chooses spectra view for the inset wave view.
  Keyboard shortcut: S or .
• Chooses spectrogram view for the inset wave view.
  Keyboard shortcut: G or /
• Copies inset wave view to the Wave Clipboard.
  Keyboard shortcut: C or Control-C
• Removes the inset wave view.
  Keyboard shortcut: Escape or Delete
C.4  Real-time Wave Viewer Toolbar and Keyboard Shortcuts

- Decreases number of seconds on the X axis.
  Keyboard shortcut: Alt-Left arrow

- Increases number of seconds on the X axis.
  Keyboard shortcut: Alt-Right arrow

- Opens the Wave View Settings Dialog.
  Keyboard shortcut: ?

- Chooses wave view.
  Keyboard shortcut: W or ,

- Chooses spectra view.
  Keyboard shortcut: S or .

- Chooses spectrogram view.
  Keyboard shortcut: G or /

- Copies wave view to the Wave Clipboard.
  Keyboard shortcut: C or Control-C

C.5  Clipboard Toolbar and Keyboard Shortcuts

- Opens a text file wave as saved by SWARM.

- Save a text file wave. See Section VI.

- Synchronizes all of the channels on the clipboard to the same time window as the selected wave.

- Removes ALL of the waves from the clipboard.

C.6  Clipboard Wave View Toolbar and Keyboard Shortcuts

- Scrolls the wave back in time by 20%.
  Keyboard shortcut: Left arrow

- Scrolls the wave forward in time by 20%.
  Keyboard shortcut: Right arrow

- Positions the wave at a user-specified time.
  Keyboard shortcut: Control-G

- Decreases amount of time on the X axis by 20%.
  Keyboard shortcut: Alt-Left arrow

- Increases amount of time on the X axis by 20%.
  Keyboard shortcut: Alt-Right arrow

- Reverts to the last time window.
  Keyboard shortcut: Backspace
• Opens the Wave View Settings Dialog.
  Keyboard shortcut: ?

• Chooses wave view.
  Keyboard shortcut: W or ,

• Chooses spectra view.
  Keyboard shortcut: S or .

• Chooses spectrogram view.
  Keyboard shortcut: G or /

• Puts another copy of the wave on the clipboard.
  Keyboard shortcut: C or Control-C

• Moves this wave up a position on the clipboard.
  Keyboard shortcut: Up arrow

• Moves this wave down a position on the clipboard.
  Keyboard shortcut: Down arrow

• Removes the wave from the clipboard.
  Keyboard shortcut: Delete
Figure 1: The data source chooser and the channel selector in SWARM
Figure 2: New data source window - Earthworm Wave Sever options

Figure 3: New data source window - Winston Wave Sever options
Figure 4: New data source window - DMC
Figure 5: Helicorder view
Figure 6: Helicorder view settings
Figure 7: The wave time-series

Figure 8: The spectrogram

Figure 9: The frequency spectra
Figure 10: Wave View Settings Dialog. Several options are available here
Figure 11: A typical Real-time Wave Viewer showing a just-occurred microquake

Figure 12: A snapshot of typical Wave Clipboard usage
Figure 13: This map image, exported from SWARM with the camera icon, shows the 2004 Indian Ocean earthquake using data from the IRIS POND Data Center.
Figure 14: A 10 monitor layout